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1.1 Introduction 
 
Integrated Building Performance Analysis (IBPA) can be a powerful tool to evaluate and inform decisions 
throughout the design process, starting at the earliest stages.  In order to design a high-performance building and 
implement an integrated process, the traditional design process needs to change.  No longer can the design team 
leave the analysis too late in design development, it needs to start early.  By working holistically from concept 
stage, the project team can analyse a number of options and make informed decisions on the associated pros and 
cons.  
 
The Virtual Environment (VE-Pro) is an integrated analysis platform developed by Integrated Environmental 
Solutions (IES).  It is a collection of building performance modelling and analysis modules leveraging a single 
integrated data model.  The intent is to provide the high quality information required to design, build and operate 
better performing, more sustainable buildings without having to build a different model for each type of analysis 
(e.g. energy, daylighting, etc.).  The VE is linked to Revit Architecture and Revit MEP through plug-ins that allow 
users to build models in Revit and then analyse them using a range of products with the Virtual Environment 
family. Integration with other BIM tools is achieved by importing data in a gbXML format into the Virtual 
Environment. The analysis tools include annual energy/carbon consumption, building loads, daylighting and electric 
lighting, climate, water, air flow and LEED/BREEAM/Greenstar credits. The Virtual Environment can be applied 
from the earliest stages of the design process, when greatest opportunity often exists for making improvements, 
right through to detailed design and even into operation of the building. 
 
A key issue to understand is that there are fundamental differences between an energy model and an architectural 
model used to generate construction documents and the ability to cycle through design options in a timely manner 
requires understanding of both.  From the Engineers perspective they require only information pertinent to the 
question at hand, reducing variables will reduce analysis time.  From the Architects perspective, the visual 
character of the overall model is important to convey the design intent as well as the detail to express the layering 
of ideas.  gbXML (refer to section 1.4 - Basic gbXML information) is used to streamline the data flow from Revit to 
IES Virtual Environment.  It is important to note that no exchange format is perfect and there are still limitations on 
what can be transferred between BIM and energy simulation software.  An important point to note is that, many 
BIM elements do not support information exchange identifying the thermal performance characteristics that are 
needed to run energy analysis.  Therefore, the users are required to specify these values at the point of translation, 
so the analysis can be performed with the appropriate characteristics.  Architects tend to want to analyse their 
‘specific’ wall design with specific layers’, when, at an early stage, identifying the wall as an R-24 (thermal value) 
may be sufficient  to develop comparative analysis between cases.  When carrying out design exploration at 
different stages of the process, it is advisable to utilise the appropriate level of detail for the analysis, making it 
easier to focus on outputs that can inform the design. Too much detail at the early stages can cloud the 
fundamental design decisions.  
 
In order to take advantage of the ability to integrate BIM + Building Performance Analysis, the BIM model needs to 
be developed with this work flow considered.  The usefulness and accuracy of the analysis results depend greatly 
on the quality of the input data.  The intent of this white paper is to provide guidance on best practice when 
creating BIM models in order to successfully export to the VE for Building Performance Analysis and to leverage the 
ability to do analysis cycles informing the design and testing ideas as the design evolves. This paper focusses on the 
Revit integration, however the principles are the same regardless of which BIM tool is being implemented.  
 
 
 
 
 
 
 
 
 
 
 



 

BIM + Building Performance Analysis Using Revit 2014 and IES Virtual Environment        3 

 

 
 
1.2 Basic gbXML Information 
 
Green Building XML schema, referred to as “gbXML”, was developed to facilitate the transfer of information from 
building information models to performance (predominantly energy) analysis tools. 

 
When the user clicks on ‘Set Model Properties’  within Revit using the IES toolbar, in the background a gbXML file 
is being read and exported. The 3D model the user sees is a gbXML model. This shows what will be exported for 
analysis, so it’s important to look at this model to see what elements will translate correctly and what won’t.  
 
XML is a web-based, standards-compliant specification that can be used to store and transport virtually any kind 
of data. It is based on a relatively simple text-based syntax similar to HTML. Green Buildings XML (gbXML) was 
developed to facilitate interoperability between myriad building design and development modelling tools.  IES is 
involved in development of the gbXML schema to enhance the translation and have included a number of 
features in the import function to smooth the gbXML import process.  
 
(Refer to www.gbxml.org for more detail information regarding gbXML documentation.) 
 
In order to facilitate a smooth translation from 3D modelling software (e.g. Revit) to the Virtual Environment there 
are a number of considerations users should be aware of when creating their BIM (Revit) model. 
 
Like any type of analysis, the usefulness and accuracy of the results depend greatly on the quality of the inputs. In 
order to take advantage of this advanced workflow between the platforms, the Revit model must be properly 
prepared for analysis. Under normal circumstances there will be a Revit model for documentation and a separate, 
stripped down version of the Revit model for export to the VE.   
 
All bounding elements from the model, i.e. the walls that make up a room, its floor and ceiling, (See section 1.12 
Surfaces) will translate as 2D surfaces which represents ‘enclosed’ geometry i.e. the 3D zone. (Rooms or spaces 
depending on what version of Revit is being used).  
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1.3 Data Exchange gbXML 
 
A gbXML document organizes information according to the following hierarchy:  Location, Building, Space, Surface 
and Opening. 

 

 
Figure 1: gbXML structure 

 
 

1.4 Adjacencies 
 

In order for the building performance model to understand whether a surface is exterior or interior, placing 
Rooms (refer to Section 1.9 - Rooms) accurately is critical. If there is no Room adjacent to another space, then the 
vertical wall is considered as an Exterior wall and the associated construction profile will be assigned. If Rooms are 
placed on both sides of walls, then it is considered as Interior. Even if the space is a shaft or an unoccupied space, 
where a room might not typically be placed, it is important in this case that a Room is inserted otherwise the 
rooms surrounding the shaft or unoccupied space will be read as exterior spaces.  Refer to the diagrams below 
which illustrate how gbXML determines surfaces. (Figures 2 – Adjacency Diagrams) 

 

 
 

Figure 2: Adjacency Diagrams 
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1.5 Checklist for Translating Revit to IESVE 
 

The following checklists/tips summarise the process users should go through in the Revit model before 
attempting to export the VE. .  Each item is described in more detail in subsequent pages of this document.  
 
1.    Rooms (refer to Section 1.9 - Rooms) 

Make sure all rooms/spaces are place in every area of the building to create a fully enclosed building 
envelope, and adjacencies of Rooms are correct. 

 
2.    Room Bounding Elements   (refer to Section 1.12) 

Check or uncheck room bounding elements that are necessary for design / building Performance 
model.  If an interior space has many ½ walls or jogs (that protrude into but do not divide spaces), 
these walls can often be made non-room bounding leaving a simple room perimeter to bound the 
space.  

 
3.  Define all Upper and Lower Boundary (refer to Section 1.14 - Defining the Upper & Lower Boundary) 
      Make sure all the Upper and Lower Limits and Offsets are correct 
 
4.    Project Information (refer to Section 1.8 - Project Information) 

Make sure the Energy Data parameter in the Project Information is filled out correctly 
 
5.   Room Volume Computations (refer to Section 1.15 - Room Volume Computations) 

      Make sure Room Volume Computations is checked 
 

6. If it’s a central model, detach from central.  
Clean up views, elements that are not related to energy analysis (casework, railings, etc.), and 
purge unused. This will help reduce the size of the file. 

 
7. Try to keep the model as lean as possible in Revit, 

This will be worth it when trying to run analysis and will impact runtime greatly. Only keep 
elements essential to the gbXML. It is common to maintain separate Revit construction document 
models and Revit analysis models, though in the future hopefully that will change. For analysis, 
simplicity of the model is paramount.  For example, use a single wall from ground floor level to the 
roof instead of stacked or layered complex wall. Use actual window families instead of a curtain 
wall embedded in opaque walls. Use simple, generic families if possible. Always use the appropriate 
family type for any custom components. 
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1.6 Work Flow Example Revit to IESVirtual Environment 
 
This diagram illustrates a typical work flow using Revit.   
 
 
 
 
 
 
1.  Design    
 
 
 
 
 
 
 
 
 
 
 
 
2.  Translate 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  Analyse 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  Carry further 

 
 
 
 

Figure 3: Typical Workflow Diagram 
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1.7 Area & Volume Computation 
 
This has to be set to ‘Areas and Volumes’ for the successful creation of a gbXML file. (See section 1.15 - how to set 
this) 

 
     Figure 4: Area and Volume Computations 
 
1.7.1 Levels 
 
In addition a room or a space has to be placed everywhere in the model to create a fully enclosed building 
envelope. These rooms/spaces (see section 1.9 Rooms and Spaces) should be tied to the levels within the model.  
This is best practice in the event that there are later updates to the floor levels which will in turn adjust the 
room/space heights automatically if they are tied. 
 

 
Figure 5: Section through Revit Model 
 
At this stage the ‘Visibility Graphics’ can be turned on to check if the room or space placed is filling the model as 
required. 
 

 
Figure 6: Visibility Graphics Dialogue within Revit 

 



 

BIM + Building Performance Analysis Using Revit 2014 and IES Virtual Environment        8 

 

 
1.8 Project Information 
 

Defining the location of the project is very important for design / energy performance analysis because this 
determines what weather data is used for the analysis.  Location and associated climate play an important role in 
the performance of the building and should be used to inform the design.  This information can be set in Revit or in 
the Virtual Environment plug-in. 
 
In Revit go to Manage > Location 

 

 
Figure 6: Setting Project Location in Revit 
 
This can also be set within the ‘Energy Analysis’ Instance within the ‘Project Information’. (Figure 7- Project 
Information > Energy Analysis >Energy Settings) In addition to the buildings location there is additional information 
that can be exported with the gbXML from Revit for building performance analysis. This information can also be set 
in the VE plugin.  Details of this information are given below. 

 

 
Figure 7: Project Information - Project Properties 
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NB:  There are a few differences between the Architecture & MEP settings (Figures 9/10 on 
the following page), but the basic information is the same.  In addition, there are other 
methods to set project information.  Location can be set on its own in the Manage>Location.  
The same information as shown above can also be set in the Analyze>Energy Settings or on 
export when it is a manual gbXML export using the Revit gbXML function.  When using the 
<Virtual Environment Plugin, this information will be extracted automatically.  

 
 

Building Type:   Specifies the type of building according to the gbXML schema 0.37  
("http://www.gbxml.org/schema" version="0.37") and Building Type spaces similar to ASHRAE Standard 90.1 
building categories. 
 
Postal Code:   Location and climate should be set correctly as this will affect analysis results.  Postal Code can 
be used to determine the location of the building. 
 
Ground Plane:   Specifies the level that serves as the ground level reference for the building.  Spaces below 
this level are considered below ground.  The default ground level in the Virtual Environment is zero. 
 
Project Phase:   Specifies the stage of construction (Existing, New Construction).  Make sure the Rooms that 
are being placed in the Revit model are in the same phase as the Project Information.  If the phase selected 
in this dialog is different than the room property specified the user will see the warning dialogue shown in 
Figure 8 below.   

 
 

 
 

Figure 8: Project Information - Project Phase - Error Dialog 
 
 
Sliver Space Tolerance:   Specifies the tolerance between surfaces within the model.  Within the Virtual 
Environment this is referred to as the adjacency separation distance.  Best practice is to leave the default that is 
defined within the Revit dialog box.  If the default is increased this could result in larger ‘sliver spaces’ which may 
allow light, solar radiation, air flow and thermal transfer between zones that in reality do not exist.   
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       Figure 9: Energy Settings - Revit Architecture 2014 

 

 
        Figure 10: Energy Settings - Revit MEP 2014 
 

 
1.8.1 Export Settings – Architecture v MEP 
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Export Complexity:   To set this go to the Settings & Info>Setting and select the gbXML Export tab.  The user can 
select from five different options ranging between Simple to Complex with Mullions and Shading Surfaces. An 
explanation of the 5 options is given below. The main advantage of this setting is that export time is reduced when 
using the simple options.  

 

 
 

 
Figure 11: VE plugin > Settings & Info 

 

 
Figure 12: VE plugin > gbXML Export Tab 

 
NB: There is one key difference between Revit MEP and Architecture in the ‘User Settings’ Dialogue.  MEP has an 
override transfer option which allows the user to export settings for rooms such as lighting loads and occupancy 
information which have been set up within Revit.   

 

 
Figure 13: MEP Space Data – Space Properties 

 
 

 
There are five levels of complexity for export, seeFigure 14 – gbXML Complexity: 
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1. Simple: Simple means that curtain walls and curtain systems are exported with one “large” opening with 
the total opening area equal to all openings; a curtain wall with 50 panels gets exported as 1 opening. This is 
appropriate for thermal simulation, particularly early stage analysis.  
 
2. Simple with Shading Surfaces: Export with simple glazing type and shading surfaces 
 
3. Complex: Complex means that curtain walls and curtain systems are exported with several openings, panel 
by panel; a curtain wall with 50 panels will be exported as 50 openings 
 
4. Complex with Shading Surfaces: This will export with a complex glazing type and include shading surfaces 
 
5. Complex with Mullions and Shading Surfaces: This export option is the most complex type, including 
shading surfaces and mullions. ‘With mullions’ means that mullions in curtain walls and systems are exported 
as shading surfaces. A “simplified” analytical shading surface is produce from a mullion based on its 
centreline, thickness and offset. Remember that this is the most complex type of export, and will create 
hundreds, even thousands of shading surfaces. Use the level necessary for the analysis required. This is 
appropriate for Radiance calculations where the user will want to see the effect of the mullions. 
 

 

 
 
 

    
 
        Figure 14: gbXML Complexity 
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1.9 Rooms & Spaces 
 

Rooms are the most fundamental element for design/building performance analysis. They are elements that 
determine the accuracy of analysis from a Revit model.  There are two different ways to model these within Revit 
which is determined by what Autodesk product the user is running. 
 

                
Revit Architecture 2014       Revit MEP 2014 

 
In Revit Architecture the user defines ROOMS in the model which the gbXML will recognise on export.  In Revit 
MEP the user defines SPACES and can do so using an automatic SPACE placement tool.  If these are not set the 
correct way round there is a warning that will pop up. (P10: Figure 8 - Project Information - Project Phase - Error 
Dialog) 
   
If this does occur then the user can define within Revit weather to export Rooms or Spaces.  To alter this go to the 
energy settings in the project information (P9 Section 1.8 Project Information) or go to File>Export>gbXML and 
open up the ‘Export gbXML’ settings dialogue.  In the ‘Export Category either can be defined for export. 
 

 
Figure 15: Export gbXML Settings – Revit 
 

NOTE: Within the gbXML schema the Space is the analogy for a Room. For the purposes of clarity in this paper we 
will refer to these elements as Rooms in all cases. 
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“Room inside a Room” 
 
The VE does translate the “room inside a room” or “donut” condition shown below, (Figure 16: Room inside a 
Room condition) but a cleaner geometry can be achieved by modelling the outer room as two parts utilising room 
separation lines. 

 

 

 
 
Figure 16: Room inside a Room condition 
 

 
Where do we see this condition? 
 

Elevator Shafts 
Chases 
Closets 
Core and Shell style buildings 
AVOID floor openings. Add these in VE if necessary 

 
Another issue to consider when creating the Revit model are the two different ways to model and define rooms 
within the Revit model; one is Zone-Based Modelling and the other is Room-Based Modelling. 
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1.9.1 Zone-Based Modelling 
 

Zone-Based modeling is the concept of modeling and defining the Room by the thermal zone.  A thermal zone is an 
individual space or group of interior spaces with the same thermal conditioning requirements. 
 
Zone-Based modeling is especially useful when the project is in early design stage, since the internal layout might 
not be certain, it is best to simplify elements as much as possible. 

 
The best way to defined Zone-Based modeling is to group all Rooms with similar thermal and space characteristics 
such as solar orientation, occupancy, lighting, and equipment loads into one Room.  For example, in an office 
building, perimeter offices that are facing a similar orientation could be combined into one ‘Room’ (Figure 18: 
Zone-Based Modeling - Floor Plan).   
 
When choosing any of these options the key is to carefully consider what outputs are required from the analysis.  
 
 

 
 

Figure 17: Zone-Based Modeling - Floor Plan - Perimeter vs Core 
 

 
 

 
Figure 18: Zone-Based Modeling - Floor Plan 
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1.9.2 Room-Based Modelling  
 

Room-Based Modeling is the concept of modeling and defining each Room as its own thermal zone.  There are 
cases where this might occur, for example, a hotel, even though the hotel suites might be all facing similar 
orientation, but since each room can be thermal controlled separately, it might be useful to use Room-Based 
Modeling method rather than Zone-Based modeling. 
 
For Room-Based Modeling, or any thermal modelling, it is important to place a “Room” in every space of the 
model, even if the space volume is a shaft.For example in Figure 20, the two rooms highlighted in red could be 
overlooked because the user does not want to analyse the results of these rooms.  However in order for the model 
to be translated correctly these must be defined as rooms otherwise the model will come through with holes and 
internal surfaces represented as external in the geometry which will affect the results.  The end goal is to achieve a 
fully enclosed building enevelope. 

 

 
Figure 19: Room-Based Modeling - Floor Plan 

 

 
 

Figure 20: Placing Rooms 
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1.10 Shading Surfaces 
 
When surface are created that are not room bounding these are interpreted as shading elements in the Virtual 
Environment when Room bounding elements are not bound by a Room. Roof Overhangs, balconies, or even 
surrounding buildings can be defined in this way and should all be considered when running building analysis 
because they will shade the building; however they should not be considered as rooms for analysis.   
 
Shading devices need to be created as an obstruction with wall, roof or mullion families (Figure 22 - Curtain Wall 
Mullions Translation). The massing tool can also be used to build shading and then apply walls, floors and roofs by 
face.  
 
Floor families and in-place systems will not translate as shading. 
 
NOTE:  Within the Virtual Environment, Shading surfaces, shading devices, surround buildings are known as 
obstructions.  For the purpose of clarity here, these items are referred to as shading surfaces throughout.  

 
 

 
Figure 21: Shading Surfaces Translation 

 

 
Figure 22: Curtain Wall Mullions Translation 
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1.11 Rooms vs Shading Surfaces  
 

The best way to check if the elements are translating as Rooms or Shading Surfaces is to go to IES Set Model 
Properties dialog (Figure 23 - IES Set Model Properties).  Elements that are in blue will be treated  as Rooms (Figure 
24 - Set Model Properties - Model Translation - Room), and elements that are in yellow will be treated as Shading 
Surfaces (Figure 25 - IES Set Model Properties - Model Translation - Room with Shading Surfaces) 
 

 

 
 
Figure 23: IES Set Model Properties 
 
 

 
 
Figure 24: Set Model Properties - Model Translation – Room 
 

 
 
Figure 25: Set Model Properties - Model Translation - Room with Shading Surfaces 
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1.12 Surfaces 
 

Rooms are defined by bound volumes for gbXML translation from a Revit model to a building performance model.   
  
During the translation of the Revit model, these bounding elements are translated into 2D surfaces that enclose 
the 3D spaces (rooms).  (See Figure 26 - Revit Model Translation to Virtual Environment) 
 
The following elements are room bounding elements for Room Area and Volume Computations: 
 
  •   Walls (Curtain, standard, in-place, face-based) 
  •   Roofs (Standard, in-place, face-based) 
  •   Floors (Standard, in-place, face-based) 
  •   Ceilings (Standard, in-place, face-based) 
  •   Columns (Architectural) 
  •   Curtain systems 
  •   Room Separation Lines 
 
The user can check or uncheck ‘Room bounding’ instance parameter (Figure 28 - Room Bounding - Instance 
Parameters).  If a room bounding element is unchecked, it will be excluded from the building performance analysis. 

 

 
Figure 26: Revit Model Translation to Virtual Environment 
 
Another situation where a Room bounding element is broken up into multiple surfaces is when rooms are adjacent 
to one another.  In order to allow for situations where one room is conditioned while the other is unconditioned, the 
separating wall is treated as two surfaces in the Revit model. 
 
 
 



 

BIM + Building Performance Analysis Using Revit 2014 and IES Virtual Environment        20 

 

 
 

 
Figure 27: Breaking Wall into Two Surfaces in Building Performance Model 
 
 
 

 
Figure 28: Room Bounding - Instance Parameter 
 
The following sections will describe some of the issues to be aware of when modelling.  Understanding these issues 
will help to produce a more accurate analysis model. This is where the differentiation between a Revit model for 
documentation purposes and a Revit model for an energy analysis purposes occurs. 
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1.12.1 Walls 
 

Revit constructions and materials are not utilised by the Virtual Environment, because they do not necessarily 
contain the thermal properties needed to conduct dynamic thermal simulations.  Therefore at the ‘Set Model 
Properties’ dialog, the user will be prompted to identify these at the building and/or room level.  

 

 
 

 
Figure 29: IES VE Building Construction Dialog 

 

 
 
 

 
 

1.12.2 Walls – Basic modelling 
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Figure 30a: Constructions 

 
Walls translate from the Centreline of the wall regardless if it’s a generic wall, interior wall or exterior wall. The 
thickness of the wall matters as this defines where the centreline will be located. Align walls based on centreline 
when designing, not wall face, if wall thickness varies. 

 
Problem wall conditions: 
 
 

 
Figure 30b: Problem wall conditions 

 
 
 
 
Wall Condition 1: Wall thickness changes on one side but align on another side. When this is imported it can 

result in holes on the exterior of the building. There is a fix for this when using the IES/Revit 
plug-in, however a standard gbXML will likely present these problems. 

Wall Condition 1 Wall Condition 2 

Wall Condition 3 Wall Condition 4 
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Figure 31a: Wall Condition 1  

 
Wall Condition 2: Sill condition where the sill is made from a wall element. The results are that the room 

perimeter is “bound” in Revit by the sill wall, not the actual exterior wall. The solution is to 
make both the sill vertical wall, but also the horizontal shelf element, non-room bounding. 

 
Figure 31b: Wall Condition 2 

 
Wall Condition 3: Two layers of wall next to each other. The result is much the same as condition 2, as the 

interior wall becomes the bounding wall, and the exterior wall becomes a shading element. 
Either make the interior wall non-room-bounding, or build the core/layers of a wall using 
the constructions rather than layering two elements. 

 
Figure 31c: Wall Condition 3 

 
Wall Condition 4: A room separation line (red) is next to the wall. This does almost the same thing, except it 

makes a HOLE on the perimeter, with a shading element over it. ONLY use room separation 
lines to separate two spaces with a hole between them (meaning divided space without a 
wall or barrier). Never use around the perimeter of a room to get it too bound quickly. If it 
is not bounding correctly, there is an issue with the Revit model that must be addressed. 

 
Figure 31d: Wall Condition 4 

 
Wall Condition 5: When a partition protrudes into a room but does not close off to create a separate space 

(Figure 30b - Problem wall conditions) you have two choices.  One, make the partitions in 
question non-room bounding or two; use room separation lines to partition off the 
required space 
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1.12.3 Floors 
 

Revit floor types do not translate directly to the Virtual Environment, because they do not contain the thermal 
properties needed to conduct dynamic thermal simulations. Therefore at the ‘Set Model Properties’ dialogue, the 
user will be prompted to identify these at the building and/or room tab (Figure 29 - IESVE Building Construction 
Dialog). If openings between floors are included   these should be removed before exporting to gbXML, as these 
will cause polygon lines to appear in the building performance model. Even though in  reality spaces such as 
stairs, risers and elevator shafts do continue through  multiple floors (Figure 32 - Openings through multiple 
floors), it is best to identify each room separately  and then create the openings within theVirtual Environment 
(Figure 32 - Floors - Model from one level to next).  

 

 
Figure 32: Openings through multiple floors/Floor Model at each Level 

 
 

Problem Floor Conditions: 
 
 
Floor Condition 1: A layer of floor construction on top of another and both are set to room bounding.  Make 

the finished floor surface non-room bounding, ideally there will be a single floor slab for 
each floor. The other issue this causes is rooms disappearing in Revit. Avoid layered walls, 
floors and generally any layered elements that bounds rooms in the gbXML hierarchy. 

 

 
Figure 33a: Floor Condition 1 

 
Floor Condition 2: A sloped floor ramp can cause similar issues to above.  Make the ramp or sloped floor non-

room bounding. If there are things like light shelves in rooms, those are also room bounding 
as they will affect the way the room volume fills the space.  

 
 

 
Figure 33b: Floor Condition 2 
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1.12.4 Roofs 
 

Revit roof types do not translate directly to the Virtual Environment, because they do not contain the thermal 
properties needed to conduct dynamic thermal simulations. Therefore at the ‘Set Model Properties’ dialogue, the 
user will be prompted to identify these at the building and/or room tab.  (Figure 31 - IESVE Building Construction 
Dialog P22)  Always specify the Upper Limit above the top of the roof. It is especially important if the roof is 
sloped or pitched. This will ensure that there are no unnecessary shading surfaces in the building performance 
model. For a sloped roof, when Areas and Volumes are checked under Area and Volume Computations, the room 
will automatically wrap around the sloped roof. (Figure 34 - Room Volume at Slope Roof) 

 

 
 

 
Figure 34 - Room Volume at Slope Roof

Room Volume above  
highest point of the room 

Check Areas & Volumes 

Automatically wraps around 
the slope in the roof 
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1.12.5 Ceilings & Columns 
 

When it comes to modelling ceiling voids the first question that has to be answered is what is being simulated.  
This will determine if there is a requirement to include the ceiling voids in the model or not.  If there is then there 
must be a room added to represent the void making sure that there is a fully enclosed building envelope with no 
air gaps.  Within Revit MEP these spaces can be marked as plenums within the space properties dialogue.  If this 
option is too complex another solution is to export the model excluding the plenum areas and model them within 
the VE.  If they are not required for the analysis purposes, then the ceiling levels can be set to non-room bounding 
and the room levels set to the floor above. 

 
 

Columns as room bounding elements will impact the volume of the building performance model.  The volume of 
the column itself is subtracted from the total Room Volume, thus reducing the room volume. It is recommended 
that these are set to be non-room bounding (Refer to Figure 36 – Columns Translation from Revit to IESVE) for all 
columns before exporting the Revit Model to the Virtual Environment. Since there is no Room defined inside of 
the columns, and the columns are translated as surfaces for geometry, the room will mistakenly identify the 
adjacent space as exterior. If the columns are critical elements for the analysis, they can be recreated within the 
Virtual Environmenti.e. Required for lighting studies. Figure 36 - Diagram on the left.  
Diagram Below Right - The Columns has room bounding “Unchecked”, and it translated successfully into Virtual 
Environment 
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1.12.6 Curtain Walls 
 

Curtain walls are “translated” into surfaces and openings for the purposes of export to a building performance 
model. A curtain wall will be translated as a Wall surface. For every glazing panel in the Curtain wall, there will be 
a window opening. If the Curtain wall is curved, it will be faceted to several planar wall surfaces. 
 
NOTE: If the glazing panel material is less than 3% transparency, it will be translated as a solid panel. 
 
Tips for better translation using curtain walls: 
 
1. Try to do a full height curtain wall if possible, or as few sections as possible. This means ideally the curtain wall 
goes from ground to roof across all the floors. To insert opaque sections into the wall, replace the glazed panel 
with a panel with 3% transparency or less and it will translate as a solid wall. DO NOT stack walls, as is common 
practice in many firms, as this confuses the room perimeter. Grid the curtain wall and adjust the panels to get the 
correct window/wall coverage, rather than many different walls, for best translation. 
2. Doors in curtain walls will not be translated. Leave as glazed panel if glazed doors, as doors will come through 
as solid panels. For it to translate as a door, it must be in the door family. Glazed doors are not an option in the 
toolkits, and must be made in the VE. 
3. Do not embed curtain walls into opaque or any other walls, as it will cause issues with the translation of the 
glazing. Keep it simple, using the correct family for the correct envelope element. Use a custom created window if 
necessary. 

 

 
 

1.12.7 Room Separation Lines 
 

Room separation lines are Room bounding elements. They are useful in building performance analysis if a large 
room needs to be calculated for different HVAC loads. For example, for separating a perimeter zone 15’-0”/6 
meters from the building envelope from an interior zone or if a large open plan area in the model is to be zoned. 
 
 
 

 
 

1.13 Openings 
 

Openings are elements such as windows, doors and skylights. They are usually hosted components in the system 
families.  Like ‘Room bounding’ elements and surfaces, openings are represented as 2D surfaces during the 
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translation from building information model to building performance model. The model will only translate what is 
needed to conduct for the analysis. Note that the railings did not translate into Virtual Environment from the 
Revit model, because they have very little, if any, influences on the analysis. 

 
 
 
  

 
1.13.1 Doors 
 
It is very important to use a door template when creating custom doors. If a door template was not used, it can 
result in the Room to extending beyond the area expected. 
 

 

1.13.1.1 Elevator Doors 
 

It is recommended to use a door template when creating elevator doors. If an elevator is required, then another 
template should be used to create that separately.  An elevator door should also be placed at each floor level the 
elevator crosses. 
 
 

1.13.1.2 Glass Doors 
 
Doors with glazed panels will not export as a glazed door during the gbXML translation.  Once exported to the 
Virtual Environment, the glazed panels can be added.  The other option is to define the door as a piece of glazing.
 
 
1.13.2 Windows 
 
When creating custom windows, it is also very important to use a window template. If a window template was 
not used. It can affect the analysis calculations by allowing air flow where none is present. 
 
 

 
1.14 Defining the Upper and Lower Boundary 

 
Together, the Upper Limit and Limit offset parameters define the upper boundary of the room. It is important to 
make sure the Upper Limit and Limit Offset is set correctly for design/energy performance analysis. If the Upper 
Limit and Limit Offset leave a void between the define area and the level above, this void area will recognised as 
exterior in the design/building performance model.  As a general rule, it is a good practice to set the Limit Offset 
to 0’-0”, and set the Upper Limit to the next level, or the height that covers the highest point in the space. The 



 

BIM + Building Performance Analysis Using Revit 2014 and IES Virtual Environment        29 

 

reason for that is for any reasons the floor to floor heights change later in the design phase, the room volume will 
always be constrained.  Use the Base Offset parameter to indicate the distance between the base level and the 
lower boundary of the room. Enter a positive number to move the lower boundary above the base level. Enter a 
negative number to move the lower boundary below the base level. 

 

 
 

Figure 39 – Properties Dialogue
 
 

1.15 Room Volume Computations 
 

Compute Room Volumes determines the room volume and room height. Room volume computations affect Revit 
performance; it is turned off by default. Before performing analysis it is critical to set this.  The Location where 
this is set is dependent on the version of Revit.  
 
Revit Architecture – It can be set on the Home tab in the Room & Area section. 
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Figure 40: Room Volume Computations setting in Revit Architecture 
 
Revit MEP – It can be set in the Analyze tab in the Spaces and Zones section. 
 

 
 

 
Figure 41: Room Volume Computations setting in Revit MEP 
 

NOTE: Room volumes are computed to the wall finish, regardless of the Room Area Computation setting. 
 

1.16 Linked RVT Files 
 

In Revit, Rooms/Spaces are recognised as room bounding elements that are placed in linked RVT models.  After 
linking the Revit model into the project, select the linked model, go to Edit Type/Type Properties in the element 
properties and make sure Room Bounding is checked.

 
1.17 Design Options 

 
If design options are used in Revit, the primary option is typically the preferred design. It is usually displayed in 
the project views by default. All others are secondary. During the export to gbXML, the primary option is the 
option that will be export.  If another option needs to be export for design/energy performance analysis, click 
tools menu > Design Options > Design Options or click on the Design Options toolbar.  
 

 
 
In the Design Options dialog, select the secondary design option to promote. Under Option, click Make Primary 
 
. 
1.18 Families 

 
Currently, lighting fixtures will not be able to export from Revit to IESVirtual Environment.  The ability for lighting 
fixtures to translate into IESVirtual Environment is under development.  Most of the families do not export during 
the gbXML translation. Components can be placed separately in Virtual Environment and used in daylight, natural 
ventilation, or CFD analyses.

 
1.18.1 Building Constructions 

 
These must be set using the IES toolbar. Constructions set in Revit don’t contain the detailed parameters such as 
material density, conductivity, vapour resistance, etc, necessary to use for a dynamic thermal analysis. 
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1.18.2 Lighting Data 
 

Currently, lighting data can be export from Revit to IESVirtual Environment. 
 
These do not export directly from Revit to Virtual Environment. If lighting files have (.ies) format photometric 
data, these can be imported and used in FlucsPro, LightPro, and RadianceIES to explore dimming strategies, 
energy usage, different layout options, etc. Many manufactures will provide the (.ies) files on their website for all 
of their luminaire products. 
 
 
1.18.3 Furniture 

 
Furniture will not export out as part of the building performance model. Components can be placed separately in 
IESVirtual Environment. 
 
1.19 Cleaning Out Existing Revit Models 

 
By reducing the amount of information in the Revit model, it can greatly reduce the file size and the runtime on 
building performance analysis. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 

1.20 Import Enhancements – Virtual Environment 
 
The new import settings have been improved and the control has been given to the user.   
 
 
Tidy Algorithm – This is a function developed by IES that runs on import gbXMLs to the Virtual Environment.  The 
user can choose to turn this function on or off with this tick box.  The tidy function will try to:  

 Close rooms 

 Add/remove vertices & edges 

 Invert surfaces when orientated incorrectly  
 
Include space boundaries resulting from columns – This function was developed to help in particular where BIM 
models are being reverse engineered for gbXML export to the Virtual Environment.  With this option deselected 
the VE will ignore columns that are in the gbXML as long as the BIM package they are coming from have them 
correctly tagged as ‘columns’. 
 
Minimum space boundary area(m2) to be considered for inclusion – this allows  the user to set a tolerance level 
which allows for small surfaces to be ignored further cleaning up the imported geometry. 
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Maximum number of surfaces to allow in space boundary (when tidying) – This option allows the user to set a 
tolerance for the tidy algorithm.  In the image of the user preferences dialogue it is set at 500, therefore all spaces 
that have less than 500 surfaces will have the ‘tidy algorithm’ applied to them.  If the space has more than 500 
surfaces the raw geometry will be imported into the VE. 
 

 
Figure 42: VE > User Preferences > Shell Import 

 
Another useful option in the ‘User Preferences’ dialogue under the ‘Inner Volume’ tab is the “Remove the 
override protection from imported inner volumes”.  Unchecking this allows for a cleaner geometry import as well 
as any geometry changes once in the Virtual Environment. 
 

 
Figure 43: VE > User Preferences > Inner Volumes 

 
 
1.21 BIM Import Report 
 
As part of the import process of a gbXML file into the Virtual Environment IES have introduced a new report that 
gives the end user a much clearer picture of the work being carried out by the software in the background in 
trying to import geometry.  The report highlights the quality of the raw gbXML before any VE algorithms are 
applied. 
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Figure 44: VE > gbXML BIM Report 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 


